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AÇIKLAMALAR 
ALAN  Bilişim Teknolojileri  

DAL/MESLEK Web Programcılığı 

MODÜLÜN ADI  Etkileşimli Web Uygulamalarında Web Formları 

MODÜLÜN TANIMI  

Bu modül, programlama yazılımı kullanarak .NET 

ortamında etkileşimli web uygulamalarında web formları 

ile ilgili temel bilgi ve becerilerin kazandırıldığı bir 

öğrenme materyalidir. 

SÜRE 40/32 

ÖNKOŞUL 
Etkileşimli Web Uygulamaları İçin Temel İşlemler 

modülünü tamamlamış olmak 

YETERLİK Web sitesi yapısını oluşturmak 

MODÜLÜN AMACI 

Genel Amaç 

 Bu modül ile gerekli ortam sağlandığında web form 

uygulamaları yapabileceksiniz. 

Amaçlar 

1. Anasayfa oluşturabilecek ve diğer sayfalar ile bağlantı 

kurabileceksiniz. 

2. Stil sayfaları oluşturabilecek ve web sayfalarını bu 

dosya üzerinden biçimlendirebileceksiniz. 

3. Web site için tema oluşturabilecek ve siteye 

uygulayabileceksiniz. 

4. Site haritası ve web sayfalarına menü ekleyerek site 

kullanımını kolaylaştırabileceksiniz. 

5. Site ve web sayfaları üzerinde durum yönetimi 

sağlayabileceksiniz. 

EĞİTİM ÖĞRETİM 

ORTAMLARI VE 

DONANIMLARI 

Ortam: Bilişim Teknolojileri laboratuvarı, işletme ortamı  
Donanım: Web programlama yazılımlarını çalıştırabilecek 

yeterlikte bilgisayar, İnternet bağlantısı 

ÖLÇME VE 

DEĞERLENDİRME 

Modül içinde yer alan her öğrenme faaliyetinden sonra 

verilen ölçme araçları ile kendinizi değerlendireceksiniz. 

Öğretmen modül sonunda ölçme aracı  (çoktan seçmeli test, 

doğru-yanlış testi, boşluk doldurma, eşleştirme vb.) 

kullanarak modül uygulamaları ile kazandığınız bilgi ve 

becerileri ölçerek sizi değerlendirecektir.  

 

AÇIKLAMALAR 
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GİRİŞ 
 

Sevgili Öğrenci, 

 

Bir web sitesinin işlevselliği, o siteyi ziyaret eden kullanıcı sayısı ile doğru orantılıdır. 

Web sitesi kullanıcılarının kaybedilmemesi veya artırılması için web sayfasının sürekli 

güncel tutulmasının yanında görünümünün de belirli aralıklarda değiştirilmesi faydası 

olacaktır. 

 

Sayfa sayısı az olan sitelerin görünümlerinin değiştirmek sorun teşkil etmese de 

gelişmiş web sitelerinin görünümlerinin değiştirilmesi problem çıkarır.  

 

Modül içinde ASP.NET web sitelerinin tasarımlarının ve görünümlerinin 

değiştirilmesi için size kolaylık sağlayacak yapılara yer verilmiş, çeşitli örnek uygulamalarla 

konular desteklenmiştir. 

 

GİRİŞ 



 

 2 



 

 3 

 

ÖĞRENME FAALİYETİ–1 
 

 

 

Anasayfa oluşturabilecek ve diğer sayfalarla bağlantı kurabileceksiniz. 

 

 

 

 

ü Bir web sayfasının her sayfasında değişmeden görüntülenen ögeleri araştırınız. 

 

1. ANASAYFA KULLANMA 
 

Bir web sitesi birden fazla sayfadan oluşur. Bu sayfalarda içerik değişirken her 

sayfada tekrarlanan ögeler ve özellikler vardır. Web sitesi hazırlanırken bir şablon 

oluşturarak şablon üzerinde içerik değişikliği ile sayfalar kolaylıkla hazırlanabilir. Ancak 

sayfa sayısı arttıkça web sitesinde güncelleme yapma bütün sayfaların tek tek elden 

geçirilerek değiştirilmesi anlamına gelmektedir. Bu durum zaman konusunda tasarımcılara 

çeşitli sıkıntılara sebep olacaktır.  

 

CSS (Cascading Style Sheets) sayfaları kullanılarak web sitesinin sayfalarının 

özelliklerine doğrudan müdahale edilebilir. Bu şekilde sitenin tüm sayfalarının stil özellikleri 

tek bir yerden kontrol edilerek kolaylıkla güncelleme yapılabilir (CSS konusuna ilerleyen 

konularda yer verilecektir). Ancak tüm sayfalarda yer alan menü, resim, logo vb. içerik 

değişikliğinde bu yöntem işe yaramayacaktır. Daha önceki konularda bahsedilen Web 

Kullanıcı Kontrolleri ile ASP.NET’te kullanılarak bu duruma çözüm getirilmiştir. 

ASP.NET’in yeni sürümleri ile birlikte web kullanıcı kontrollerinin yanında Anasayfa 

(MasterPage) özelliği eklenerek tasarımcılara büyük kolaylıklar sağlanmıştır. 

 

Resim 1.1: MasterPage Sayfası (a) Sabit Alanlar (b) İçerik Alanı 

MasterPage kullanımı ile birlikte sitenin tasarımı oluşturulmaktadır. MasterPage 

üzerinde sabit kalması ve değişmesi istenen alanlar belirlenir. MasterPage kullanılarak siteye 

yeni eklenen bir sayfa tasarım uygulanır. MasterPage üzerinde yapılan bir değişiklik 

programlama yazılımı ile MasterPage kullanılan tüm sayfalarda otomatik olarak 

güncellenmektedir. 

ARAŞTIRMA 

ÖĞRENME FAALİYETİ–1 
 

AMAÇ 
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1.1. Anasayfa Oluşturma 
 

MasterPage sayfaları standart ASP.NET sayfaları ile benzerlik göstermektedir. Dosya 

uzantısı .master’dır. ASP.NET sayfaları @Page direktifi ile başlarken MasterPage sayfaları 

@Master direktifi ile başlamaktadır. Temel bu iki fark haricinde tasarımı standart ASP.NET 

sayfaları ile aynıdır.  

 

Web sitesine bir MasterPage eklemek için; 

 

ü Add New Item ï FormSite iletişim penceresinden MasterPage komutunu seçin. 

 

Resim 1.2: MasterPage sayfasının eklenmesi 

MasterPage sayfasında tüm sayfalarda görüntülenmesi istenen alanlar belirlenebilir. 

Sayfalara özgü alanlar ise ContentPlaceHolder kontrolü ile belirlenir. ContentPlaceHolder 

kontrolü, MasterPage sayfalarından türeyen sayfalarda içeriği değişen alanları ifade eder. 

Programlama yazılımı yeni eklenen MasterPage sayfasına iki tane ContentPlaceHolder 

kontrolü ekler. Birincisi sayfa tanımlamaların yapılması için Head etiketi içinde, ikincisi ise 

içeriğin eklenmesi için Body etiketi içindedir. 

 
<head runat ="server">  
  <title ></ title > 
  <asp: ContentPlaceHolder  id ="head"  runat ="server">  
  </ asp: ContentPlaceHolder > 
</ head> 
<body> 
  <form  id ="form1"  runat ="server">  
   <div > 
    <asp: ContentPlaceHolder  id ="ContentPlaceHolder1"  runat ="server">  
    </ asp: ContentPlaceHolder > 
   </ div > 
  </ form > 
</ body> 
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1.2. Anasayfadan Web Sayfası Türetme 
 

Bir web projesinde birden fazla MasterPage kullanılabilir. Programlama yazılımı web 

sitesine yeni bir web form eklerken MasterPage sayfalarından birinin seçilerek sayfanın 

türetilmesine olanak sağlar. 

 

MasterPage sayfasından sayfa türetmek için; 

 

ü Add New Item ï FormSite iletişim penceresinden Web Form komutunu seçin. 

 

Resim 1.3: Web form eklenmesi 

ü Web form komutu seçildikten sonra Add New Item ï FormSite iletişim 

penceresi sol alt bölümünde Select Master Page seçeneği aktif hale gelecektir. 

Bu alanı işaretleyin. 

 

Resim 1.4: Select MasterPage seçeneği 
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ü Add butonuna tıklayın. Ekrana gelen Select a Master Page iletişim 

penceresinden uygun MasterPage sayfasını seçin ve onaylayın. 

 

Resim 1.5: Select a Master Page iletişim penceresi 

MasterPage sayfasından sayfa türetmenin diğer bir yolu ise, MasterPage sayfası 

üzerinde sağ tıklayıp Add Content Page komutunun seçilmesidir. Bu durumda programlama 

yazılımı otomatik olarak seçilen MasterPage sayfasından türemiş yeni bir sayfa web sitesine 

ekleyecektir. 

 

MasterPage sayfasından türemiş olan sayfanın kodları aşağıdaki gibi olacaktır. Kodlar 

incelenecek olursa @Page direktifi ile başlayan satırda hangi MasterPage sayfasından 

türetildiği belirtilmektedir. Ayrıca MasterPage sayfasında Form etiketi kullanıldığı için 

türeyen sayfa kodlarında Form etiketi yer almaz. 

 
<%@ Page Title =""  Language="C#"  MasterPageFile ="~/MasterPage.master"  
AutoEventWireup ="true"  CodeFile ="Default4.aspx.cs"  Inherits ="Default4"  %> 
 
<asp: Content  ID="Content1"  ContentPla ceHolderID ="head"  Runat="Server">  
</ asp: Content > 
 
<asp: Content  ID="Content2"  ContentPlaceHolderID ="ContentPlaceHolder1"  
Runat="Server"></ asp: Content > 

 

MasterPage sayfaları tarayıcıda tek başlarına görüntülenmez. MasterPage 

görüntülenmek istenmesi durumunda MasterPage sayfasından türeyen bir sayfa ile 

görüntülenmelidir. 
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UYGULAMA FAALİYETİ 
 

Anasayfa kullanımı ile ilgili aşağıdaki uygulamayı yapınız. 

 

İşlem Basamakları Öneriler 

ü Yeni boş bir web sitesi oluşturun. 

ü File >New > Web Site komutu 

seçebilirsiniz. 

ü New Web Site iletişim penceresinden 

ASP.NET Empty Web Site komutunu 

seçebilirsiniz. 

ü Siteye yeni bir Anasayfa ekleyin. 

ü Solution Explorer panelinden site 

adını sağ tıklayarak Add > Add New 

Item ya da Web Site > Add New Item 

komutunu kullanabilirsiniz. 

ü Add New Item iletişim penceresinden 

Master Page komutunu 

kullanabilirsiniz. 

ü Anasayfa görünümünü aşağıdaki gibi 

değiştirin. 

 

ü Tasarım için tablodan 

faydalanabilirsiniz. 

ü (a) sabit alanları, (b) sayfalarda 

değişecek alanları ifade etmektedir. 

ü Sabit alanları birbirinden ayırt etmek için 

isimlendirin. 

ü Üst sabit alan için ¦ST ALAN, sağ 

alan için SAĴ ALAN, sol alan için 

SOL ALAN ve alt alan için ALT 

ALAN isimlerini kullanabilirsiniz. 

ü Anasayfayı kaydedin ve bu sayfadan iki 

tane sayfa türetin. 

ü Add New Item iletişim penceresinden 

Web Form komutunu seçebilirsiniz. 

ü Select Master Page seçeneğini 

seçebilir ve sonraki adımda 

anasayfayı seçebilirsiniz. 

ya da 

Master Page seçili iken Web Site > 

Add Content Page komutunu 

seçebilirsiniz. 

ü Sayfaları çalıştırın ve görünümü inceleyin. 
ü Debug > Start Debugging (F5) 

komutunu kullanabilirsiniz. 

UYGULAMA FAALİYETİ 
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KONTROL LİSTESİ 
 

 

Bu faaliyet kapsamında aşağıda listelenen davranışlardan kazandığınız beceriler için 

Evet, kazanamadığınız beceriler için Hayır kutucuğuna  (X) işareti koyarak kendinizi 

değerlendiriniz. 

 

Değerlendirme Ölçütleri Evet Hayır 

1. Anasayfa oluşturabildiniz mi?   

2. Anasayfa üzerinde istediğiniz tasarımı gerçekleştirebildiniz mi?   

3. Anasayfadan sayfa türetebildiniz mi?   

 

 

 

DEĞERLENDİRME 
 

Değerlendirme sonunda “Hayır” şeklindeki cevaplarınızı bir daha gözden geçiriniz. 

Kendinizi yeterli görmüyorsanız öğrenme faaliyetini tekrar ediniz. Bütün cevaplarınız 

“Evet” ise “Ölçme ve Değerlendirme”ye geçiniz. 
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ÖLÇME VE DEĞERLENDİRME 
Aşağıdaki cümlelerin başında boş bırakılan parantezlere, cümlelerde verilen 

bilgiler doğru ise D, yanlış ise Y yazınız. 
 

1. (   ) Anasayfa programlama yazılımında MasterPage olarak adlandırılmaktadır. 

 

2. (   ) Bir web sitesine bir tane MasterPage eklenebilir. 

 

3. (   ) Bir MasterPage üzerinde sayfalarda değişen ve sabit kalan alanlar belirlenebilir. 

 

4. (   ) MasterPage üzerinde yapılan değişiklik diğer sayfalara tek tek yansıtılmalıdır. 

 

5. (   ) Masterpage kodları @Page direktifi ile başlar. 

 

6. (   ) Sayfalarda değişen alanlar ContentPlaceHolder kontrolü ile belirlenir. 

 

7. (   ) Bir MasterPage’de birden fazla ContentPlaceHolder kontrolü eklenebilir. 

 

8. (   ) Türetilen sayfanın kodlarında hangi MasterPage sayfasından türetildiği @Page 

direktifi içinde belirtilir. 

 

 

 

DEĞERLENDİRME 
 

Cevaplarınızı cevap anahtarıyla karşılaştırınız. Yanlış cevap verdiğiniz ya da cevap 

verirken tereddüt ettiğiniz sorularla ilgili konuları faaliyete geri dönerek tekrarlayınız. 

Cevaplarınızın tümü doğru ise bir sonraki öğrenme faaliyetine geçiniz. 

ÖLÇME VE DEĞERLENDİRME 
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ÖĞRENME FAALİYETİ–2 
 
 

 

Stil sayfaları oluşturabilecek ve diğer sayfalar ile bağlantı kurabilecektir. 

 

 
 

 

ü Stil sayfalarının HTML web sitelerinde kullanımını araştırınız. 

 

2. STİL SAYFALARI KULLANMA 
 

Stil sayfaları kullanılarak bir web sitesindeki HTML kontrolleri ve HTML 

etiketlerinin sayfaların kullanıcılara nasıl görüneceği ayrı bir dosyada tutulabilir. CSS 

(Cascading Style Sheets) olarak adlandırılan bu dosyaların güncellenmesi ile sitede bu stili 

kullanan tüm sayfalar otomatik olarak güncellenir. 

 

2.1. Sayfa Ögelerini Ayrı Ayrı Biçimlendirme 
 

Web sayfalarında kullanılan ögeler diğer ögelerden bağımsız olarak 

biçimlendirilebilir. Ögeleri biçimlendirmek için Properties paneli veya sayfa kodları 

kullanılabilir. 

 

Sayfa ögelerini ayrı ayrı biçimlendirmek için; 

 

ü Yeni bir sayfa açın ve sayfaya aşağıdaki sunucu kontrollerini ekleyin. 

 

Resim 2.1: Stil uygulanacak sunucu kontrolleri 

ü Birinci kontrolü seçin ve Properties panelinden özelliklerini değiştirin. 

 

Resim 2.2: TextBox1 özellikleri 

ÖĞRENME FAALİYETİ–2 
 

AMAÇ 

ARAŞTIRMA 
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ü İkinci kontrol özelliklerini kodlarla değiştirin. 

 
<asp: TextBox  ID="TextBox2"  runat ="serv er"  BackColor ="Yellow"  
BorderColor ="Red"  BorderStyle ="Double"  ForeColor ="Blue"  Font -
Italic ="True"></ asp: TextBox > 

 

ü Üçüncü kontrolde değişik yapmayın. 

 

ü Uygulamayı çalıştırın ve kontrol görünümlerini inceleyin. 

 

Resim 2.3: Biçimlendirme uygulanmış sunucu kontrolleri 

2.2. Stil Dosyalarını Kullanma 
 

Bir önceki konuda yer alan ögelerin her birinin ayrı ayrı biçimlendirilmesi oldukça 

zahmetli ve zaman alan bir yöntem olacaktır. Programlama yazılımı geliştiricilere stil 

dosyalarını ASP.NET’te kullanarak daha kolay tasarım yapmalarını sağlamaktadır. 

 

2.2.1. Stil Sayfası Dosyası Oluşturma 
 

Web sitesine yeni bir stil dosyası eklemek için; 

 

ü Add New Item iletişim penceresinden Style Sheet komutunu seçin. 

 

Resim 2.4: Stil dosyası eklenmesi 

ü Stil dosyasına bir ad verin ve onaylayın. 
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ü Solution Explorer panelinden stil dosyasını isterseniz bir klasör altına 

taşıyabilirsiniz. 

 

ü Stil sayfası ekrana gelecektir. Stil sayfası ilk eklendiğinde stil sayfasında sadece 

body etiketi ile açılır.  

 

Resim 2.5: Stil sayfası dosyası 

ü Yeni stil kuralına bir isim verin. Stil isminin başında nokta kullanmayı 

unutmayın. 

 
.textbox  {  

}  

 

ü Programlama yazılımı kod tamamlama (intellisense) özelliği ile rahatlıkla stil 

sayfasında kural oluşturulabilir. 

 

Resim 2.6: Kod tamamlama (Intellisesnse) özelliği 

ü Stil parantezleri arasına aşağıdaki kuralları yazın. 

 
.textbox  {  

    background - color : Red;  

    border - color : #f8f305 ;  

    border - style : double ;  

    font - family : Arial ;  

    font - size : medium;  

}  
 

ü Stil dosyasını kaydedin. 

 

2.2.2. Web Sitesinde Paylaşılmış Stiller Kullanma 
 

Hazırlanan bir stili sayfalarda kullanmak için; 

 

ü Stil ekleyeceğiniz sayfayı açın. 

 

ü Sayfaya stil uygulamak için iki tane TextBox kontrolü ekleyin. 
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ü <head>é</head> etiketleri arasında stil dosyasını tanımlamak için aşağıdaki 

kodları ekleyin. 

 
<link  rel ="stylesheet"  type ="text/css"  href ="StyleSheet.css"  />  

 

ü Kontrollerin her biri için eğer bir CSS sınıf kuralı kullanacak ise mutlaka 

CssClass özelliği ile tanımlanmalıdır. 

 
<asp: TextBox  ID="TextBox2"  runat ="server"  CssClass ="textbox">  
</ asp: Text Box> 
 

ü Stil uygulanan kontrol aşağıdaki gibi görünecektir. 

 

Resim 2.7: Stil uygulanmış kontrolün görünümü 
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UYGULAMA FAALİYETİ 
 

Bir stil dosyası oluşturarak web sayfasına bağlayınız. 

 

İşlem Basamakları Öneriler 

ü Yeni bir boş web projesi oluşturun. 

ü File > New > Web Site komutunu 

kullanabilirsiniz. 

ü New WebSite iletişim penceresinden 

ASP.NET Empty Web Site komutunu 

kullanabilirsiniz. 

ü Siteye yeni bir stil sayfası ekleyin. 

ü Solution Explorer panelinden site adını 

sağ tıklayarak Add > Add New Item ya 

da Web Site > Add New Item komutunu 

kullanabilirsiniz. 

ü Add New Item iletişim penceresinden 

Style Sheet komutunu kullanabilirsiniz. 

ü Sayfa stili kurallarını ekleyin. 
body {  

    background : yellow ;  

    font - family : Tahoma;  

}  

ü Kod tamamlama özelliği ile kolaylıkla 

kod ekleyebilirsiniz. 

ü Button kontrolü için kuralları belirleyin. 

.button  {  

    background - color : Red;  

    border - color : #000;  

    border - style : double ;  

    font - family : Tahoma;  

}  

ü Kod tamamlama özelliği ile kolaylıkla 

kod ekleyebilirsiniz. 

ü Textbox kontrolü için kuralları belirleyin. 

.textbox  {  

    background - color : #0ff ;  

    border - color : #0026ff ;  

    border - style : dashed;  

    font - family : Tahoma;  

}  

ü Kod tamamlama özelliği ile kolaylıkla 

kod ekleyebilirsiniz. 

ü Label kontrolü için kuralları belirleyin. 

.label  {  

    background - color : #fff ;  

    border - color : red ;  

    font - family : Tahoma;  

}  

ü Kod tamamlama özelliği ile kolaylıkla 

kod ekleyebilirsiniz. 

UYGULAMA FAALİYETİ 
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ü Sayfaya kontrolleri ekleyin. ü Toolbox panelini kullanabilirsiniz. 

ü Sayfaya stil dosyasını bağlayın. 

 
<link  rel ="stylesheet"  t ype="text/css"  

href ="StyleSheet.css"  />  

 

ü Sayfa kodlarında <head>é</head> 

etiketleri arasında dosyayı 

tanımlayabilirsiniz. 

ü Kontrollere stilleri atayın. 

ü Properties panelinde CssClass 

özelliğini ya da kontrol kodlarına 

CssClass etiketini kullanabilirsiniz. 

ü Uygulamayı çalıştırın ve kontrollerin 

stillerini gözlemleyin. 

 

ü Debug > Start Debugging (F5) 

komutunu kullanabilirsiniz. 
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KONTROL LİSTESİ 
 

 

Bu faaliyet kapsamında aşağıda listelenen davranışlardan kazandığınız beceriler için 

Evet, kazanamadığınız beceriler için Hayır kutucuğuna  (X) işareti koyarak kendinizi 

değerlendiriniz. 

 

Değerlendirme Ölçütleri Evet Hayır 

1. Yeni web projesi oluşturabildiniz mi?   

2. Stil sayfası ekleyebildiniz mi?   

3. Stil kurallarını ekleyebildiniz mi?   

4. Sayfaya stil dosyasını bağlayabildiniz mi?   

5. Kontrollere stil atayabildiniz mi?   

 

 

 

DEĞERLENDİRME 
 

Değerlendirme sonunda “Hayır” şeklindeki cevaplarınızı bir daha gözden geçiriniz. 

Kendinizi yeterli görmüyorsanız öğrenme faaliyetini tekrar ediniz. Bütün cevaplarınız 

“Evet” ise “Ölçme ve Değerlendirme”ye geçiniz. 
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ÖLÇME VE DEĞERLENDİRME 
 

Aşağıdaki cümlelerin başında boş bırakılan parantezlere, cümlelerde verilen 

bilgiler doğru ise D, yanlış ise Y yazınız. 
 

1. (   ) Stil dosyası değiştirildiğinde bu stili kullanan tüm sayfalar otomatik olarak 

güncellenir. 

 

2. (   ) Stil dosyası kullanmadan sayfada kullanılan ögeler Properties paneli kullanılarak 

ayrı ayrı biçimlendirilebilir. 

 

3. (   ) Stil dosyaları hazırlanırken kod tamamlama özelliği kullanılmaz. 

 

4. (   ) Stil dosyasına yeni kural eklenirken kural isminin önüne . (nokta) işareti konur. 

 

5. (   ) Stil dosyaları sayfaya bağlanırken <body>é</body> etiketleri arasında 

tanımlanır. 

 

6. (   ) Kontrollere stil tanımlanırken CSSClass özelliği kullanılır. 

 

 

 

DEĞERLENDİRME 
 

Cevaplarınızı cevap anahtarıyla karşılaştırınız. Yanlış cevap verdiğiniz ya da cevap 

verirken tereddüt ettiğiniz sorularla ilgili konuları faaliyete geri dönerek tekrarlayınız. 

Cevaplarınızın tümü doğru ise bir sonraki öğrenme faaliyetine geçiniz. 

ÖLÇME VE DEĞERLENDİRME 
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ÖĞRENME FAALİYETİ–3 
 

 

 

Web sayfası için tema oluşturabilecek ve siteye uygulayabileceksiniz. 

 

 

 

 

ü Web sitelerinde görünümün ara ara değiştirilmesinin faydalarını araştırınız. 

 

3. TEMALARI KULLANMA 
 

3.1. ASP.NET Temaları 
 

Bir web sayfanın işlevselliği siteyi ziyaret eden kullanıcı sayısı ile doğru orantılıdır. 

Bu nedenle sitenin görünümü büyük önem taşımaktadır. Sitenin görünümünün iyi olmasının 

yanında görünümün ara ara değiştirilmesi siteyi ziyaret eden kullanıcı sayısını olumlu yönde 

etkileyecektir. 

 

Sayfa sayısı az olan bir sitenin görünümünü değiştirmek pek sorun teşkil etmeyebilir, 

ancak sayfa sayısı arttıkça bir sitede görünümü değiştirmek oldukça büyük problemlere yol 

açacaktır. Bu durum CSS (Cascading Style Sheet) ile giderilse de ASP.NET’te yeterli 

olmamaktadır. 

 

ASP.NET’te genel olarak bir sitenin görünümünün nasıl olacağını belirleyen yapılar 

yani temalar geliştirilmiştir. Temalar web sitesindeki tüm sayfalara web.config dosyasına 

yazılacak kodlarla uygulanabilmektedir. 

 

 

3.1.1. Yeni Tema Oluşturma 
 

App_Themes klasörü ASP.NET’te temaları saklamak için kullanılır. App_Themes 

klasörü altında yer alan klasörler de ASP.NET özel klasörleridir ve Theme klasörü olarak 

adlandırılır. Uygulamaya Theme klasörleri eklendikten sonra klasör içine SKIN dosyaları, 

CSS dosyaları ve resimler eklenebilir. 

 

Yeni bir tema oluşturmak için; 

 

ü Solution Explorer panelinde, web sitesinin adını sağ tıklayın ve Add > ASP.NET 

Folder > Theme komutunu seçin. 

 

ü App_Themes klasörü eklenmiş durumda değilse programlama yazılımı otomatik 

olarak ekleyecektir.  

ÖĞRENME FAALİYETİ–3 
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ü Tema klasör içine dış görünüm dosyası, stil dosyaları (CSS) ve resimler 

ekleyebilirsiniz. 

 

3.1.2. Dış Görünüm Ekleme 
 

Theme klasörü içine skin dosyaları eklenerek kontrollerin dış görünümleri 

değiştirilebilir. Skin dosyaları ASP.NET sunucu kontrollerinin stillerini barındıran 

dosyalardır. Bir tema tanımlandığında sayfaya istek geldiğinde sayfalar kullanıcıya 

gönderilirken kontroller skin dosyalarında tanımlı stiller uygulanarak gönderilir. Bir skin 

dosyasında bir kontrol için birden fazla stil uygulanabilir. 

 

Temaya bir skin dosyası eklemek için; 

 

ü Add New Item iletişim penceresinden Skin File komutunu seçin. 

 

Resim 3.1: Skin dosyası ekleme 

ü Skin dosyasına bir ad verin ve onaylayın. 

 

ü Skin dosyası eklendikten sonra örnek olarak iki skin eklenecektir. Bunlar 

GridView ve Image kontrolü için tanımlanmıştır. 

 
<%--  

Default skin template. The following skins are provided as examples only.  

1. Named control skin. The SkinId should be uniquely defined because  

   duplicate SkinId's per control type are not allowed in the same theme.  

<asp:Gr idView runat="server" SkinId="gridviewSkin" BackColor="White" >  

   <AlternatingRowStyle BackColor="Blue" />  

</asp:GridView>  
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2. Default skin. The SkinId is not defined. Only one default  

   control skin per control type is allowed in the same theme.  

<asp:I mage runat="server" ImageUrl="~/images/image1.jpg" />  

-- %> 

 

ü Kodlar incelenecek olursa skin dosyalarındaki kullanılan kodların kontrol 

kodları ile benzerlik gösterdiği görülecektir. Farklı olarak ID özelliği yerine 

SkinID özelliği yer almaktadır.  

 

ü SkinID özelliği kullanımı zorunlu değildir. SkinID özelliği tanımlanmamışsa 

Default Skin, tanımlanmışsa Named Skin olarak adlandırılır. Bu özelliğin 

kullanımı ilerleyen konularda anlatılacaktır. 

 

ü Örnek bir butona ait skin kodlaması aşağıdaki gibidir. 

 
<asp: Button  runat ="server"   

  BackColor ="Red"   

  ForeColor ="Yellow"   

  Font - Name="Arial"   

  Font - Size ="14px"  />  

 

ü Programlama yazılımı ortamında skin dosyalarının kodlaması sırasında kod 

tamamlama (intellisense) özelliği çalışmaz. Skin dosyalarında daha hızlı ve 

doğru kodlama yapılabilmesi için sayfa kodlarından bir kontrole ait özellikler 

belirlendikten sonra bu kodlar skin dosyasına kopyalanıp ID özelliğinin 

silinmesi yeterli olacaktır. 

 
<asp: TextBox  runat ="server"  

  BackColor ="Red"  

  BorderColor ="Yellow"  

  BorderWidth ="1px"  

  Font - Bold ="True"  

  Font - Italic ="True"  

  ForeColor ="White"></ asp: TextBox > 

 

Bir uygulamaya birden fazla skin dosyası eklenebilir. Burada dikkat edilmesi gereken 

skin dosyalarının adlandırılmasında aynı ismin kullanılmamasıdır. Kod karmaşıklığının 

önüne geçilmesi için her kontrol için ayrı skin dosyası oluşturulabilir. 
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3.1.3. CSS Ekleme 
 

Skin dosyaları sadece kontrollerin dış görünümlerinin ayarlanması için 

kullanılmaktadır. Ancak temalarla birlikte bütün sayfada değişiklik yapılması istenebilir. Bu 

durumda HTML kontrolleri ve HTML etiketlerinin görünümünü ayarlamak için CSS 

dosyaları kullanılır. 

 

Temaya bir CSS dosyası eklemek için; 

 

ü Add New Item iletişim penceresinden Style Sheet komutunu seçin. 

 

ü CSS dosyasına bir ad verin ve onaylayın. 

 

ü CSS dosyasını Solution Explorer panelinden tema klasörünün altına taşıyın. 

 

ü CSS dosyasını önceki konularda anlatıldığı şekilde kodlayabilirsiniz. 

 

3.2. Temaların Uygulanması 
 

Oluşturulan temalar sitenin tamamına ya da sayfa düzeyinde uygulanabilir. Daha 

önceki uygulamalarda hatırlanacağı gibi sitenin tamamı için web.config dosyası, sayfa 

bazında ise @Page direktifi kullanılır. 

 

3.2.1. Sayfaya Tema Uygulama 
 

Sayfa düzeyinde tema uygulamak için @Page direktifi altındaki Theme özelliği 

kullanılır. Theme özelliği eklendikten sonra programlama yazılımı uygulamadaki temaları 

otomatik olarak listeleyecektir.  

 

Resim 3.2: Sayfa düzeyinde tema uygulama 

Sayfaya tema uygulandıktan sonra, skin dosyasında tanımlanan özellikler kontrollere, 

CSS ile tanımlanan özellikler ise HTML kontrollerine ve HTML etiketlerine otomatik olarak 

uygulanacaktır. 

 

SkinID özelliği ile bir kontrole Named Skin uygulanabilir. Sayfaya tema uygulanmış 

olsa bile Named Skin çalışacaktır.  

 

Bir kontrole Named Skin uygulamak için; 

 

ü Kontrol özellikleri kodlayın ve SkinID atayın. 
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<asp: Button  SkinID ="ozel"  runat ="server"   

  BackColor ="Yellow"   

  ForeColor ="Red"   

  Font - Name="Arial"   

  Font - Size ="14px"  />  

 

ü Properties paneli Skin ID özelliğine Skin dosyasında tanımladığınız ismi girin. 

 

Resim 3.3: SkinID özelliğinin ayarlanması 

Bazı durumlarda sayfaya tema uygulanmasına rağmen bir kontrole temanın 

uygulanması istenmeyebilir. Bir kontroldeki tema uygulamasını iptal etmek için 

EnableTheming özelliğinin False olarak ayarlanması yeterli olacaktır. Bu durumda kontrol 

varsayılan görünümü ile görüntülenir. 

 

Sayfanın tasarım aşaması sırasında tema belirlenebileceği gibi çalışma zamanında da 

tema ataması yapılabilir. Kullanıcılar çalışma zamanında siteyi bu özellik sayesinde kendi 

isteklerine göre kişiselleştirebilecektir. SkinID özelliği ile bir kontrole ait birden fazla tema 

belirlenebileceği unutulmamalıdır. 

 

Sayfanın temasının çalışma zamanında belirlenebilmesi için kontroller oluşturulmadan 

gerekli kodlar Pre_Init olayına yazılmalıdır.  

 
void  Page_PreInit( object  sender, EventArgs  e)  

  {  

     Page.Theme = "SkinFile2" ;  

  }  

 

3.2.2. Siteye Tema Uygulama 
 

Site düzeyinde tema belirlemek için Web.config dosyasına ekleme yapılmalıdır 

<System.web>é</System.web> etiketleri arasına <pages> etiketi ile tema eklenebilir. 

Böylece sayfalara tek tek tema uygulamak yerine sitenin tamamına tema uygulanmış 

olmaktadır. 
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<sys tem.web> 

ƛ 

<pages theme=" tema1" />  

ƛ 

</ system.web > 

 

Yukarıdaki kodlar Web.config dosyasına eklendikten sonra sitenin teması Tema1 

olarak otomatik olarak ayarlanır. Eğer site teması haricinde bir sayfaya aynı zamanda sayfa 

düzeyinde de tema uygulanmışsa sayfa düzeyindeki tema geçerli olacaktır. 

 

Siteye tema uygulandıktan sonra bazı sayfalarda temanın uygulanması istenmeyebilir. 

Bu durumda @Page direktifi EnableTheming özelliği False olarak ayarlanmalıdır. 
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UYGULAMA FAALİYETİ 
 

ASP.NET web sitesinde tema kullanımı ile ilgili aşağıdaki uygulamayı yapınız. 

 

İşlem Basamakları Öneriler 

ü Uygulama faaliyeti 1’deki web sitesini 

açın. 
ü Start Page penceresini kullanabilirsiniz. 

ü Uygulamaya bir tema klasörü ekleyin. 

ü Solution Explorer panelinde site adını 

sağ tıklayarak Add > ASP.NET Folder > 

Theme komutunu seçebilirsiniz. 

ü Temaya bir dış görünüm dosyası 

ekleyin. 

ü Add New Item iletişim penceresinden 

Skin File komutunu seçebilirsiniz. 

ü Tema dış görünüm dosyasına aşağıdaki 

kodları yazın. 
<asp: CheckBox runat ="server"   
BackColor ="Red"   
BorderColor ="Yellow"  
BorderStyle ="Dotted"  
Font - Bold ="True"  
Font - Size ="Smaller"   
Height ="20px"  
Width ="125px"  />  

ü Kontrolü sayfa ekledikten sonra 

özellikleri Properties panelinden 

ayarlayabilirsiniz. 

ü Özellikler skin dosyasına id özelliğini 

silebilirsiniz. 

ü Yeni bir sayfa oluşturun ve temayı 

sayfaya uygulayın. 
<%@ Page Language="C#"  
AutoEventWireup ="true"  Theme="Theme1" 
CodeFile ="Default.aspx.cs"  
Inherits ="Default"  %> 

ü @Page direktifi Theme özelliğini 

kullanabilirsiniz. 

ü Sayfaya bir CheckBox kontrolü ekleyin. 

 

ü ToolBox panelini kullanabilirsiniz. 

ü CheckBox kontrolünün metnini Deneme 

olarak ayarlayın. 

 

ü Properties panelinden Text özelliğini 

kullanabilirsiniz. 

ü Uygulamayı çalıştırın. 

 

ü Debug > Start Debugging (F5) 

komutunu kullanabilirsiniz. 

UYGULAMA FAALİYETİ 
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KONTROL LİSTESİ 
 

 

Bu faaliyet kapsamında aşağıda listelenen davranışlardan kazandığınız beceriler için 

Evet, kazanamadığınız beceriler için Hayır kutucuğuna  (X) işareti koyarak kendinizi 

değerlendiriniz. 

 

Değerlendirme Ölçütleri Evet Hayır 

1. Web sitesine bir tema ekleyebildiniz mi?   

2. Temaya bir dış görünümü dosyası ekleyebildiniz mi?   

3. Dış görünüm dosyasını kodlayabildiniz mi?   

4. Temayı sayfaya uygulayabildiniz mi?   

 

 

 

DEĞERLENDİRME 
 

Değerlendirme sonunda “Hayır” şeklindeki cevaplarınızı bir daha gözden geçiriniz. 

Kendinizi yeterli görmüyorsanız öğrenme faaliyetini tekrar ediniz. Bütün cevaplarınız 

“Evet” ise “Ölçme ve Değerlendirme”ye geçiniz. 
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ÖLÇME VE DEĞERLENDİRME 
 

Aşağıdaki cümlelerin başında boş bırakılan parantezlere, cümlelerde verilen 

bilgiler doğru ise D, yanlış ise Y yazınız. 
 

1. (   ) Temalar genel olarak web sitesinin nasıl olacağını belirleyen yapılardır. 

 

2. (   ) App_Themes ASP.NET’te temaları saklamak için kullanılan özel klasördür. 

 

3. (   ) Dış görünüm dosyalarının uzantısı .skin’dir. 

 

4. (   ) SkinID özelliğinin kullanılması zorunludur. 

 

5. (   ) Dış görünüm dosyaları kodlanırken kod tamamlama (intellisense) özelliğinden 

faydalanabilir. 

 

6. (   ) Sayfalara temalar @Page direktifi içine yazılan Theme özelliği ile eklenir. 

 

7. (   ) Bir kontrole uygulanmış temayı iptal etmek için EnabledTheming özelliği True 

olarak ayarlanmalıdır. 

 

8. (   ) Siteye tema Web.config dosyasına yazılan kodlarla eklenebilir. 

 

 

 

DEĞERLENDİRME 
 

Cevaplarınızı cevap anahtarıyla karşılaştırınız. Yanlış cevap verdiğiniz ya da cevap 

verirken tereddüt ettiğiniz sorularla ilgili konuları faaliyete geri dönerek tekrarlayınız. 

Cevaplarınızın tümü doğru ise bir sonraki öğrenme faaliyetine geçiniz. 

 

ÖLÇME VE DEĞERLENDİRME 
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ÖĞRENME FAALİYETİ–4 
 

 

 

Site haritası ve web sayfalarına menü ekleyerek site kullanımını 

kolaylaştırabileceksiniz. 

 

 

 

 

ü Site haritasını araştırınız. 

ü Çeşitli web sitelerinde kullanılan menüleri inceleyiniz. 

 

4. SAYFA YÖNLENDİRME 
 

Bir web sayfası birden fazla sayfadan oluşmaktadır. Bu sayfalar arasında siteyi ziyaret 

eden kullanıcıların kolaylıkla dolaşabilmesi ve sitenin hiyerarşik yapısı hakkında bilgi sahibi 

olması büyük önem taşır. Programlama yazılımı, geliştiricilere bunları kolaylıkla 

yapabilmeleri için çeşitli menüler, site haritası ve site haritası yolu gibi çeşitli özellikler 

sunmaktadır. Bu özellikler kolaylıkla web sitesine eklenerek sitenin daha etkin bir hale 

getirilmesi sağlanabilir. 

 

4.1. Site Haritası 
 

Site haritası, web sitesinin sayfalarının hiyerarşik bir yapıda gösterilmesi için 

kullanılır. Programlama yazılımı ile site haritası oluşturmak için SiteMap dosyaları kullanılır. 

Bu dosyanın uzantısı .sitemap’tir. SiteMap dosyası diğer kontroller tarafından veri kaynağı 

olarak kullanılır. SiteMapDataSource kontrolü ile SiteMap dosyasından veriler okunur ve bu 

bilgiler menü vb. kontrollere aktarılabilir. 

 

Web sitesinde bir site haritası oluşturmak için; 

 

ü Add New Item –FormSite iletişim penceresinden SiteMap komutunu seçin. 

 

Resim 4.1: SiteMap dosyasının eklenmesi 

ÖĞRENME FAALİYETİ–4 
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ü SiteMap dosyası eklendikten sonra bu dosyada web sitesine ait sayfaların 

belirtilmesi gerekir. Aşağıdaki kodları inceleyin. 

 
<?xml version =" 1.0 "  encoding =" utf - 8"  ?> 

<siteMap  xmlns =" http://schemas.microsoft.com/AspNet/SiteMap - File - 1.0 "  > 

  <siteMapNode  url =""  title =""   description ="" > 

    <siteMapNode  url =""  title =""   description =""  />  

    <siteMapN ode url =""  title =""   description =""  />  

  </ siteMapNode > 

</ siteMap > 

 

ü SiteMap dosyasına bir sayfa eklenecekse sitemapNode etiketi kullanılır. Eğer 

eklenen sayfa alt düzeyde bir sayfa ise <siteMapNode>.....</siteMapNode> 

etiketleri arasında belirtilir. Bir alt düzeyde sayfa yoksa <siteMapNode /> 

etiketi ile sonlandırılır. 

 

ü url alanına SiteMap içerisinde görüntülenecek sayfaların yolunu girin. 

 
url =" default.aspx "  
 

ü title alanına sayfaların gösterileceği kontroldeki başlık bilgisini girin. 

 
title =" Anasayfa "  
 

ü desription alanına ise sayfalar ile ilgili açıklamaları girin. 

 
description =" Anasayfa "  
 

Sayfa sayısı az olan web siteleri için bir SiteMap dosyasında sayfaların 

gösterilmesinde herhangi bir problem olmayacaktır. Ancak sayfa sayısı çok fazla olan bir 

sitede karmaşıklığa yol açacaktır. Bu durumda SiteMap içindeki veriler hiyerarşik yapıya 

göre farklı SiteMap dosyalarında tutularak web.sitemap dosyasında birleştirilebilir. Böylece 

karmaşıklığın önüne geçilmiş olur. web.sitemap dosyasının kodları aşağıdaki gibi 

düzenlenmelidir. 

 
<?xml version =" 1.0 "  encoding =" utf - 8"  ?> 

<siteMap  xmlns =" http://schemas.microsoft.com/AspNet/SiteMap - File - 1.0 "  > 

  <siteMapNode  url =" default.aspx "  title =" Anasayfa "   description =" Anasayfa " > 

    <siteMapNode  siteMapFile =" SiteMap1.sitemap " />  

    <siteMapNode  siteMapFile =" SiteMap2.sitemap " />  

  </ siteMapNode > 

</ siteMap > 
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SiteMap dosyası hazırlandıktan sonra bu dosyadaki değerlerin bir kontrole aktarılması 

gerekir. Bir SiteMap dosyasından verileri okumak ve başka bir kontrole aktarmak için 

SiteMapDataSource kontrolü kullanılır. SiteMapDataSource kontrolü, yol belirtilmeksizin 

kök klasörü içinde web.sitemap dosyasını arar ve otomatik olarak okur. 

 

SiteMapDataSource kontrolü Toolbox panelinde Data başlığı altında yer almaktadır. 

Sayfaya buradan eklenebilir. 

 

SiteMapDataSource kontrolü tek başına bir işlev görmeyecektir. SiteMap dosyası 

içindeki verileri sadece okuma işlemi yapar. Okuduğu bu verilerin menü vb. bir kontrole 

aktarılması gerekir. Bunun için; 

 

ü Boş bir sayfa ekleyin. 

 

ü SiteMapDataSource kontrolünü sayfaya ekleyin. 

 

Resim 4.2: SiteMapDataSource kontrolü 

ü Toolbox paneli Navigation başlığı altından TreeView kontrolünü sayfaya 

ekleyin. 

 

Resim 4.3: TreeView kontrolü 

ü TreeView kontrolü Choose Data Source özelliğinden oluşturduğunuz 

SiteMapDataSource kontrolünü gösterin. 

 

Resim 4.4: SiteMapDataSource kontrolünün verilerinin aktarılması 

ü Aktarma işleminden sonra SiteMap dosyasında belirlenen sayfalar TreeView 

kontrolünde gösterilecektir.  
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Resim 4.5: Oluşturulmuş site haritası 

4.2. Menüler 
 

Programlama yazılımı geliştiricilerin kolaylıkla menü hazırlayabilmeleri için Toolbox 

panelinde Navigation başlığı altında çeşitli kontroller sağlamaktadır. Bu kontrollere veriler 

statik olarak eklenebileceği gibi çalışma zamanında da dinamik olarak eklenebilir. 

 

4.2.1. Açılır ve Efektli Menüler 
 

Toolbox paneli Navigation başlığı altında yer alan Menu kontrolü sayfaya eklenerek 

yatay veya dikey görünümde açılır menüler eklenebilir. Bu menüler JavaScript kod 

kullanılarak programlama yazılımında otomatik olarak oluşturulur. JavaScript kod bilmeye 

gerek yoktur. 

 

Sayfa açılır menü eklemek için; 

 

ü Toolbox paneli Navigation başlığı altında Menu kontrolünü sayfaya ekleyin. 

 

Resim 4.6: Menu kontrolü 

ü Menu kontrolünün görev menüsünden Edit Menu Items komutunu seçin. 

 

ü Ekrana gelen Menu Item Editor iletişim penceresinden; 

 

 Add a root item komutu ile menüye ana menü başlığı ekleyebilirsiniz. 

 

 Add a child item komutu ile menüye alt menü başlığı ekleyebilirsiniz. 

 

 Remove an item komutu ile menü ögelerini silebilirsiniz. 
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 Bunların dışında menü ögelerinin yerlerini oklarla değiştirebilir, menü 

başlıklarının seviyesini bu iletişim penceresinden değiştirebilirsiniz. 

 

Resim 4.7: Menu Item Editor iletişim penceresi 

ü Web sitesinde kullanmayı düşündüğünüz menü ögelerini ekleyin. Çalışmanın 

ilerleyen bölümlerinde de istenildiği zaman menüler düzenlenebilir. 

 

Resim 4.8: Menu kontrolüne öge eklenmesi 

ü Her ögenin özelliklerinin ayarlanması gerekmektedir. Düzenlemek istediğiniz 

menü ögesini seçin ve iletişim penceresinin sağ tarafındaki özellikleri ayarlayın. 

 

Resim 4.9: Menü ögesi özellikleri 
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 Text özelliği menü ögesinin metnini belirtir. 

 

 NavigateUrl özelliği menü ögesi tıklandığında açılacak olan sayfayı 

belirtir. 

 

 Target özelliği ise açılacak sayfanın hedef penceresini belirtir. 

 

Resim 4.10: Açılır menü 

ü İstendiğinde diğer kontrollerde olduğu gibi kontrol kodlarından da menü 

üzerinde değişiklik yapılabilir. 

 
<asp: Menu ID="Menu1" runat ="server">  

  <Items > 

    <asp: MenuItem Text ="Anasayfa"  Value ="anasayfa"></ asp: MenuItem> 

    <asp: MenuItem Text ="Alan lar"  Value ="alan">  

       <asp: MenuItem Textˮʏ"ÉÌÉīÉÍ 4ÅËÎÏÌÏÊÉÌÅÒÉʏ Value ="bilisim">  

       <asp: MenuItem Textˮʏ!û eīÌÅÔÍÅÎÌÉûÉʏ Value ="ag"></ asp: MenuItem> 

       <asp: MenuItem Text ="Bilgisayar Teknik Servisi"  Value ="teknik">  

       </ asp: MenuItem> 

       <asp: MenuItem Textˮʏ6ÅÒÉÔÁÂÁÎĈ 0ÒÏÇÒÁÍÃĈÌĈûĈʏ Value ="vertabani">  

       </ asp: MenuItem> 

       <asp: MenuItem Textˮʏ7ÅÂ 0ÒÏÇÒÁÍÃĈÌĈûĈʏ Value ="web"></ asp: MenuItem> 

       </ asp: MenuItem> 

    </ asp: MenuItem> 

    <asp: MenuItem TextˮʏÉÌÅÔÉīÉÍʏ Value ="iletisim" ></ asp: MenuItem> 

  </ Items > 

</ asp: Menu> 

 

ü Görev menüsünde AutoFormat özelliği ile programlama yazılımı menü 

şablonları kullanılabilir. 

 

Resim 4.11: Menu kontrollünün görünümünün değiştirilmesi 
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4.2.2. Ağaç Görünümlü Menüler 
 

Programlama yazılımında ağaç görünümlü menüler oluşturmak için Toolbox paneli 

Navigation başlığı altındaki TreeView kontrolü kullanılır. Menu kontrolünde olduğu gibi 

TreeView kontrolüne de öge eklenebilir. Farklı olarak Items yerine TreeView kontrolünde 

Nodes kullanılmaktadır. TreeView kontrolüne öge eklemek için görev menüsünden Edit 

Nodes özelliği kullanılır. TreeView Node Editor iletişim penceresinden TreeView kontrolüne 

Menu kontrolündeki gibi öge eklenebilir.  

 

Sayfa ağaç görünümlü menü eklemek için; 

 

ü Toolbox paneli Navigation başlığı altında TreeView kontrolünü sayfaya ekleyin. 

 

Resim 4.12: TreeView kontrolü 

ü TreeView kontrolünün görev menüsünden Edit Nodes komutunu seçin. 

 

ü Ekrana gelen TreeView Node Editor iletişim penceresinden; 

 

 Add a root node komutu ile menüye ana menü başlığı ekleyebilirsiniz. 

 

 Add a child node komutu ile menüye alt menü başlığı ekleyebilirsiniz. 

 

 Remove an node komutu ile menü ögelerini silebilirsiniz. 

 

 Bunların dışında menü ögelerinin yerlerini oklarla değiştirebilir, menü 

başlıklarının seviyesini bu iletişim penceresinden değiştirebilirsiniz. 

 

Resim 4.13: TreeView Node Editor iletişim penceresi 
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ü Web sitesinde kullanmayı düşündüğünüz menü ögelerini ekleyin. Çalışmanın 

ilerleyen bölümlerinde de istenildiği zaman menüler düzenlenebilir. 

 

Resim 4.14: TreeView kontrolüne öge eklenmesi 

ü Her ögenin özelliklerinin ayarlanması gerekmektedir. Düzenlemek istediğiniz 

menü ögesini seçin ve iletişim penceresinin sağ tarafındaki özellikleri ayarlayın. 

 

Resim 4.15: TreeView ögesi özellikleri 

 Text özelliği menü ögesinin metnini belirtir. 

 

 NavigateUrl özelliği menü ögesi tıklandığında açılacak olan sayfayı 

belirtir. 

 

 Target özelliği ise açılacak sayfanın hedef penceresini belirtir. 

 

Resim 4.16: Açılır menü 
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ü İstendiğinde diğer kontrollerde olduğu gibi kontrol kodlarından da ağaç 

görünümlü menü üzerinde değişiklik yapılabilir. 

 
<asp: TreeView  ID="TreeView1"  runat ="server">  

  <Nodes> 

    <asp: TreeNode Text ="Anasayfa"  Value ="Anasayfa"></ asp: TreeNode> 

    <asp: TreeNode Text ="Alanlar"  Value ="Alanlar">  

     <asp: TreeNode Textˮʏ"ÉÌÉīÉÍ 4Åknolojileri"  Valueˮʏ"ÉÌÉīÉÍ 4ÅËÎÏÌÏÊÉÌÅÒÉʏ˲ 

<asp: TreeNode Textˮʏ!û eīÌÅÔÍÅÎÌÉûÉʏ Valueˮʏ!û eīÌÅÔÍÅÎÌÉûÉʏ˲ 

</ asp: TreeNode> 

<asp: TreeNode Text ="Bilgisayar Teknik Servisi"  

Value ="Bilgisayar Teknik Servisi"></ asp: TreeNode> 

<asp: TreeNode Textˮʏ6ÅÒÉÔÁÂÁÎĈ 0ÒÏÇÒÁÍÃĈÌĈûĈʏ Valueˮʏ6ÅÒÉÔÁÂÁÎĈ 

0ÒÏÇÒÁÍÃĈÌĈûĈʏ˲ 

</ asp: TreeNode> 

<asp: TreeNode Textˮʏ7ÅÂ 0ÒÏÇÒÁÍÃĈÌĈûĈʏ Value ="Web 

0ÒÏÇÒÁÍÃĈÌĈûĈʏ˲˱Ƴasp: TreeNode> 

     </ asp: TreeNode> 

    </ asp: TreeNode> 

    <asp: TreeNode TextˮʏeÌÅÔÉīÉÍʏ ValueˮʏeÌÅÔÉīÉÍʏ˲˱Ƴasp: TreeNode> 

  </ Nodes> 

</ asp: TreeView > 

 

ü Görev menüsünde AutoFormat özelliği ile programlama yazılımı TreeView 

şablonları kullanılabilir. 

 

Resim 4.17: TreeView kontrollünün görünümünün değiştirilmesi 
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ü TreeView kontrolü içeren bir sayfa açıldığında varsayılan olarak tüm seviyeler 

açılır. Ancak istendiğinde sayfa açıldığında hangi seviyelerin açılacağı 

ayarlanabilir. Bunun için TreeView kontrolü ExpandDepth özelliğinden seviye 

0’dan başlayarak belirlenebilir. FullyExpand olarak seçilirse tüm seviyeler 

gösterilir. 

 

Resim 4.18: Treview kontrolü gösterilecek seviyelerin belirlenmesi 

4.2.3. Site Haritası Yolu 
 

Kullanıcılar sitede dolaşırken bulunduğu sayfa hiyerarşik olarak gösterilebilir. 

Böylece üst seviyelere rahatlıkla geri dönülmesi sağlanabilir. Programlama yazılımı bunu 

gerçekleştirmek için SiteMapPath kontrolüne sahiptir. SiteMapPath kontörlü sayfaya 

eklendikten sonra SiteMap dosyası içerisindeki bilgileri otomatik olarak okur. 

 

Site Haritası Yolu eklemek için; 

 

ü Toolbox paneli Navigation başlığı altında SiteMapPath kontrolünü sayfaya 

ekleyin. 

 

Resim 4.19: SiteMapPath kontrolü 

ü SiteMapPath kontrolü SiteMap dosyasından verileri otomatik olarak okuyarak 

eklenen sayfanın hiyerarşik olarak yerini gösterecektir. 
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UYGULAMA FAALİYETİ 
 

Aşağıdaki işlem basamaklarını takip ederek ağaç görünümlü menü kullanarak bir 

sitemap oluşturunuz. 

 

İşlem Basamakları Öneriler 

ü Yeni bir boş web projesi oluşturun. 

ü File > New > Web Site komutunu 

kullanabilirsiniz. 

ü New WebSite iletişim penceresinden 

ASP.NET Empty Web Site komutunu 

kullanabilirsiniz. 

ü Web sitesine dört tane web sayfası 

ekleyin. 

ü Website > Add New Item iletişim 

penceresini kullanabilirsiniz. 

ü Web sitesine SiteMap dosyası ekleyin. 
ü Website > Add New Item iletişim 

penceresini kullanabilirsiniz. 

ü SiteMap dosyası kodlarına sayfaları 

ekleyin. 

 
<?xml version =" 1.0 "  encoding =" utf - 8"  
?> 
<siteMap  
xmlns=" http://schemas.microsoft.com/ 
AspNet/SiteMap - File - 1.0 "  > 
    <siteMapNode  url =""  title =" Site 
(ÁÒÉÔÁÓĈ"   description ="" > 
        <siteMapNode  
url =" default.aspx "  title =" Sayfa 1 "   
description =" Sayfa1 "  />  
        <siteMapNode  
url =" default2.aspx "  title =" Sayfa 2 "   
description =" Sayfa2 "  />  
        <siteMapNode  
url =" default3.aspx "  title =" Sayfa 3 "   
description =" Sayfa3 "  />  
        <siteMapNode  
url =" default4.aspx "  title =" Site 
(ÁÒÉÔÁÓĈ"   description =" Sayfa4 "  />  
    </ si teMapNode> 
</ siteMap > 
 

 

 

ü Sayfa 4’e gelin ve SiteMap dosyasındaki 

verileri okumak için sayfaya 

SiteMapDataSource kontrolü ekleyin. 

 

 

ü ToolBox panelini kullanabilirsiniz. 

UYGULAMA FAALİYETİ 
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ü Sayfa 4’e SiteMap dosyasındaki verilerin 

gösterilmesi için TreeView kontrolü 

ekleyin. 

 

ü ToolBox panelini kullanabilirsiniz. 

ü TreeView kontrolü görünümü değiştirin. 

ü TreeView kontrolü görev menüsünden 

Auto Format özelliğini 

kullanabilirsiniz. 

ü TreeView kontrolüne SiteMapDataSource 

kontrolü verileri aktarın. 

ü TreeView kontrolü görev menüsünden 

Choose Data Source özelliğini 

kullanabilirsiniz. 

ü Sayfa 4ôü tarayıcıda görüntüleyin. 

 

ü Debug > Start Debugging (F5) 

komutunu kullanabilirsiniz. 
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KONTROL LİSTESİ 
 

 

Bu faaliyet kapsamında aşağıda listelenen davranışlardan kazandığınız beceriler için 

Evet, kazanamadığınız beceriler için Hayır kutucuğuna  (X) işareti koyarak kendinizi 

değerlendiriniz. 

 

Değerlendirme Ölçütleri Evet Hayır 

1. Yeni proje oluşturabildiniz mi?   

2. SiteMap dosyası oluşturabildiniz mi?   

3. SiteMap dosyasında sayfaları tanımlayabildiniz mi?   

4. SiteMap dosyası verilerini okumak için SiteMapDataSource 

kontrolünü ekleyebildiniz mi? 
  

5. Site haritası için menü ekleyebildiniz mi?   

6. Menünün görünümünü değiştirebildiniz mi?   

7. Menüye SiteMapDataSource verilerini aktarabildiniz mi?   

8. SiteMap sayfasını çalıştırabildiniz mi?   

 

 

 

DEĞERLENDİRME 
 

Değerlendirme sonunda “Hayır” şeklindeki cevaplarınızı bir daha gözden geçiriniz. 

Kendinizi yeterli görmüyorsanız öğrenme faaliyetini tekrar ediniz. Bütün cevaplarınız 

“Evet” ise “Ölçme ve Değerlendirme”ye geçiniz. 
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ÖLÇME VE DEĞERLENDİRME 
 

Aşağıdaki cümlelerin başında boş bırakılan parantezlere, cümlelerde verilen 

bilgiler doğru ise D, yanlış ise Y yazınız. 
 

1. (   ) Site haritası web sitesinin sayfalarının hiyerarşik bir yapıda görüntülenmesini 

sağlar. 

 

2. (   ) Bir web sayfasında sadece bir tane SiteMap dosyası kullanılabilir. 

 

3. (   ) SiteMapDataSource kontrolü SiteMap dosyasından verileri okumak için kullanılır. 

 

4. (   ) SiteMap verileri bir menü kontrolüne aktarılabilir. 

 

5. (   ) Açılır menülerin ögeleri sadece statik olarak atanabilir. 

 

6. (   ) Ağaç görünümlü menülerin görünümleri değiştirilemez. 

 

7. (   ) Site haritası yolu için SiteMapPath kontrolü kullanılır. 

 

8. (   ) SiteMapPath kontrolü verileri SiteMap dosyasını otomatik olarak çeker. 

 

 

 

DEĞERLENDİRME 
 

Cevaplarınızı cevap anahtarıyla karşılaştırınız. Yanlış cevap verdiğiniz ya da cevap 

verirken tereddüt ettiğiniz sorularla ilgili konuları faaliyete geri dönerek tekrarlayınız. 

Cevaplarınızın tümü doğru ise bir sonraki öğrenme faaliyetine geçiniz. 

ÖLÇME VE DEĞERLENDİRME 
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ÖĞRENME FAALİYETİ–5 
 

 

 

Site ve web sayfaları üzerinde durum yönetimi sağlayabileceksiniz. 

 

 

 

 

ü Durum yöneticilerine neden ihtiyaç duyulduğunu araştırınız. 

 

5. DURUM YÖNETİCİSİ 
 

Web sayfaları kullanılırken istemci ve sunucu arasındaki bilgi alış verişi HTTP 

protokolü aracılığıyla gerçekleştirilmektedir. Geleneksel web programlamada, istemci ile 

sunucu arasındaki gerçekleşen bilgi alış verişinde, istemciden sunucuya iletilen bilgiler kalıcı 

değildir ve tekrar erişilemez. Bilgiler kullanıldıktan sonra sunucu belleğinden kaldırılır. 

 

Geleneksel web programlamada bu sınırlamayı aşmak için ASP.NET içerisinde 

istemci bilgilerine tekrar ulaşılabilmesi, bu bilgilerin saklanması ve taşınması için bazı 

yapılar oluşturulmuştur. 

 

Web uygulamalarında veriler için durum yönetimi sağlayarak verilerin sunucu ya da 

istemci tarafından saklanmasını sağlayan yapılara durum yºnetimi nesneleri adı 

verilmektedir. Bunlar; 

 

ü Sorgulama Cümlesi (Query String) 

 

ü Görünüm Durumu Yönetimi (View State Management) 

 

ü Çerezler (Cookies) 

 

ü Oturum Yönetimi (Session Management) 

 

ü Uygulama Durum Yönetimi (Application State Management) 

 

5.1. Sorgulama Cümlesi (QueryString) 
 

QueryString nesnesi ile sayfalar arasında taşınacak veri direk olarak URL aracılığıyla 

taşınır. Taşınacak olan veriler sayfanın adresinden sonra soru işareti (?) başlayan kısımda 

taşınır. Bu yöntem hem kullanım kolaylığı hem de sunucuya getirdiği yükün az olması 

nedeniyle çokça tercih edilmektedir. 

 

ÖĞRENME FAALİYETİ–5 
 

AMAÇ 

ARAŞTIRMA 
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Resim 5.1: QueryString ile veri aktarımı 

Resimdeki URL adresi incelenecek olursa q=3308 şeklinde sözcük belirtilmiştir. 

Aramayı daha da detaylandırmak için & işareti ile anahtar kelimeler kullanılmıştır. 

 

QueryString ile taşınan veriler kullanıcılar tarafından görüntülenebilmektedir. Bu 

durum güvenlik açığı oluşturmaktadır. Veriler şifreli gönderilse bile şifreli metinler 

kullanıcılar tarafından görülmesi güvenlik açığını % 100 ortadan kaldırmamaktadır. Bu 

nedenle QueryString ile güvenliği önemli bilgiler taşınmamalıdır. 

 

QueryString ile veri aktarımı yapmak için; 

 

ü Boş bir sayfa açın ve aşağıdaki kontrolleri ekleyin. 

 

Resim 5.2: QueryString ile verilerin kontrollerle aktarılması 

ü Button Click olayına aşağıdaki kodları ekleyin. 

 
Response.Redirect( "default2.aspx?Goruntule=" +TextBox1.Text+ "" );  
 

ü İkinci bir sayfa ekleyin ve Page_Load metoduna aşağıdaki kodları ekleyin. 

 
string  yaz = Request.QueryString[ "Goruntule" ];  

Response.Write(yaz);  

 

ü Uygulamayı çalıştırın ve metin kutusuna bir değer girin. 

 

Resim 5.3: QueryString ile aktarılacak verinin girilmesi 

ü Button tıklandıktan sonra ikinci sayfanın açıldığında sayfa adresinde 

QueryString ile girilen değerin aktarıldığı görebilirsiniz. 

 

Resim 5.4: QueryString ile veri aktarılan sayfa adresi 

ü Açılan ikinci sayfada aktarılan veri görebilirsiniz. 

 

Resim 5.5: QueryString ile aktarılan veri 
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5.2. Görünüm Durumu Yönetimi (ViewState) 
 

ASP.NET’te form düzeyinde verileri saklamak için kullanılan ViewState nesnesi, 

sayfa içindeki kontrol özelliklerini ve geliştiricilerin istediği verileri saklar. Bu veriler 

PostBack işlemi gerçekleştiğinde şifrelenmiş bir şekilde ViewState içerisine yazılır. Sayfa 

tekrar yüklendiğinde kontrol özellikleri ViewState nesnesinden okunur. 

 

ViewState nesnesi ile bir kontroldeki veri aktarılması için kontrolün EnableViewState 

özelliğinin True olarak ayarlanması gerekmektedir. Varsayılan olarak bu özellik True 

değerdedir. 

 

Kontrollerin sadece Text özelliği değil tüm özellikleri (Widht, Height vb.) ViewState 

nesnesi ile taşınmaktadır. 

 

ViewState nesnesi ile verileri aktarmak için; 

 

ü Yeni bir sayfa açın. 

 

ü Aşağıdaki kontrolleri sayfaya ekleyin. 

 

Resim 5.6: ViewState ile kontrol özelliklerinin aktarılması 

ü Button Click olayına aşağıdaki kodları ekleyin. 

 
ListBox1.Items.Add(TextBox1.Text);  
 

ü ListBox kontrolünün EnableViewState özelliğini False olarak ayarlayın. 

Varsayılan değeri True değerdedir. 

 

Resim 5.7: EnableViewState özelliği 

ü Uygulamayı çalıştırın ve Ekle butonu aracılığıyla TextBox içindeki metni 

ListBox kontrolüne aktarın. Bu işlemi birkaç defa tekrarlayın. 
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ü Her eklemede ListBox kontrolündeki değerler PostBack işleminden sonra 

aktarılmayacak ve yeni değer ListBox kontrolüne eklenecektir. 

 

Resim 5.8: EnableViewState özelliği false değerde iken ekran çıktısı 

ü ListBox kontrolünün EnableViewState özelliğini True olarak ayarlayın.  

 

ü Uygulamayı çalıştırın ve Ekle butonu aracılığıyla TextBox içindeki metni 

ListBox kontrolüne aktarın. Bu işlemi birkaç defa tekrarlayın. 

 

ü Her eklemede ListBox kontrolündeki değerler PostBack işleminden sonra 

korunacak ve yeni değer ListBox kontrolüne eklenecektir. 

 

Resim 5.9: EnableViewState özelliği true değerde iken ekran çıktısı 

5.3. Çerezler (Cookies) 
 

Web uygulamalarında verilerin başka bir aktarılma yöntemi ise verilerin kullanıcıların 

bilgisayarında fiziksel olarak saklanmasıdır. Cookie nesnesi istemci bilgisayarında verileri 

fiziksel olarak saklamak için kullanılır. Fiziksel ortamda saklandığı için istenilen zamanda 

verilere erişilebilir. Ancak bir dezavantajı vardır; kullanıcılar Cookie kaydını engelledikleri 

zaman kullanılamayabilir. 

 

Cookie nesnesi ile ilgili işlemler yapılabilmesi için ASP.NET uygulamalarında 

HttpCookies sınıfı kullanılmaktadır. HttpCookies sınıfından oluşturulan nesne ile Cookie 

bilgilerinin yazılması, okunması ve bilgilerin saklanacağı süre işlemleri yapılabilir. 

 

Bilgileri HttpCookies kullanarak kaydetmek için; 

 

ü Yeni bir sayfa açın. 

 

ü Aşağıdaki kontrolleri sayfaya ekleyin. 

 

Resim 5.10: Cookie nesnesi uygulaması 



 

 45 

ü Cookieôye Aktar butonuna aşağıdaki kodları ekleyin. 

 
HttpCookie  cerez = new HttpCookie ( "CookieAktar" );  

cerez[ "bilgi" ] = TextBox1.Text;  

cerez.Expires = DateTime.Now.AddDays(10);  

Response.Cookies.Add(cer ez);  

 

ü Cookieôden Aktar butonuna aşağıdaki kodları ekleyin. 

 
HttpCookie  cerezaktar = Request.Cookies[ "CookieAktar" ];  

Label2.Text = cerezaktar[ "bilgi" ];  

 

ü Uygulamayı çalıştırın ve Cookie değerini aktarın. 

 

Resim 5.11: Bilgilerin Cookie’ye aktarılması 

ü Cookieôden Aktar butonu ile bilgiyi okutun. 

 

Resim 5.12: Bilgilerin Cookie’den aktarılması 

 

5.4. Oturum Yönetimi (Session Management) 
 

Web sunucusu, kendisinden bir sayfa talep edildiğinde her kullanıcı için bir oturum 

başlatır. Oluşturulan kullanıcı oturumu boyunca Session nesnesi ile sayfalar arasında bilgi 

taşıma işlemi yapılabilir. Session nesnesi ile saklanan bilgilere oturum açık olduğu sürece her 

sayfadan ulaşılabilir, oturum kapatıldığı anda yok edilir. 

 

Oturum açan her kullanıcı için bir SessinID değeri üretilir. Bu değer hem sunucuda 

hem de istemci tarafında saklanır. Sunucu istek gelen istemciyi SessionID değerlerini 

karşılaştırarak belirler. SessionID değeri istemci tarafında Cookie’ler aracılığıyla saklanır. 

Cookie istemcide aktif değilse URL ile birlikte saklanabilmektedir. 

 

Session nesnesi sunucuda çalışan bir nesne olduğu için SessionID değeri haricinde 

istemciye bir bilgi gönderilmez, bilgiler sunucuda saklanır. Sunucu belleğinin verimli 

kullanılabilmesi sadece önemli bilgilerin Session nesnesi ile taşınması, önemsiz bilgilerin ise 

QueryString nesnesi ile taşınması uygun olacaktır. 
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Session nesnesinin kullanımı için; 

 

ü Yeni bir MasterPage ve bu sayfadan iki tane türemiş sayfa oluşturun. 

 

ü MasterPage sayfasına aşağıdaki kontrolleri ekleyin. (Sayfalar arası geçiş için 

SiteMapPath - Site Haritasē Yolu eklenmiştir.) 

 

Resim 5.13: MasterPage sayfası tasarımı 

ü Sayfa 1 ve Sayfa 2’yi ayırt etmek için bu sayfalara bilgiler girin. 

 

Resim 5.14: Türemiş sayfaların tasarımı 

ü MasterPage sayfası Page_Load olayına aşağıdaki kodları ekleyin.  

 

if  (Session[ "KullaniciAdi" ] == null )  

  {  

    Label1.Text = ʏ:ÉÙÁÒÅÔëÉƞʏ;  

    Button2.Visible = false ;  

  }  

else  

  {  

    Label1.Text = Session[ "KullaniciAdi" ].ToString();  

    Label2.Visible = false ;  

    Label3.Visible = false ;  

    TextBox1.Visible = false ;  

    TextBox2.Visible = false ;  

    Button1.Visible = false ;  

    Button2.Visible = true ;  

  }  
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ü Bu kodlar ile Session nesnesi ile bir bilgi taşınıp taşınmadığı kontrol edilmiştir. 

Bilgi taşınmıyorsa kullanıcı adı Ziyareti olarak girilmektedir. Bir değer 

taşınıyorsa kullanıcı adı yazılmış ve giriş paneli gizlenmiştir. 

 

ü Giriĸ butonu Click olayına aşağıdaki kodları ekleyin. 

 
if  (TextBox1.Text == "Admin"  && TextBox2.Text == "1234" )  

  {  

    Session.Add( "KullaniciAdi" , TextBox1.Text);  

    Label1.Text = Session[ "KullaniciAdi" ].ToString();  

    Response.Redirect( "Default2.aspx" );  

  }  

 

ü Bu kodlar ile kullanıcı adı ve şifre kontrol edilmiş ve kullanıcı adı Session 

nesnesine aktarılmıştır. Kullanıcı adı aktarılmış ve sayfa 2’ye yönlendirilmiştir. 

 

ü Sayfa 2’nin oturum açılmadan görüntülenmesini engellemek için page_Load 

olayına aşağıdaki kodları yazın. 

 
if  (Session[ "KullaniciAdi" ] == null )  

  {  

    Response.Redirect( "default.aspx" );  

  }  

 

ü Oturumu kapat butonu tıklandığında giriş sayfasına geçiş yapmak için Click 

olayına aşağıdaki kodları yazın. 

 
Session.Abandon();  

Response.Redirect( "Default.aspx" );  

 

ü Uygulamayı çalıştırın ve giriş yapın. 

 

Resim 5.15: Sayfa görüntüleri 

ü Oturumu kapattığınızda sayfa ilk haline geri dönecektir. 
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5.5. Uygulama Durum Yönetimi (Application State Management) 
 

Application nesnesi ile web sitesinin tamamını ilgilendiren bilgiler tutulur. Siteye 

erişen her kullanıcı Application nesnesi ile tutulan bilgileri görebilir, yani bu nesne ile 

tutulan her bilgi tüm kullanıcılar için ortaktır. 

 

Application nesnesinin kullanımına örnek olarak; 

 

ü Bir önceki uygulamayı çalıştırın. 

 

ü MasterPage sayfasının tasarımını aşağıdaki gibi değiştirin. 

 

Resim 5.16: MasterPage sayfası tasarımı 

ü Online kullanıcı sayısını kontrol edilebilmesi uygulamaya Glabal.asax 

dosyasının eklenmesi gerekmektedir. Uygulamada bu dosya ekli değilse Add 

New Item iletişim penceresinden Global Application Class komutu seçilmelidir. 

 

ü void  Application_Start  metodu altına aşağıdaki kodları ekleyin. Bu kod 

uygulama başlatıldığında kullanıcı sayısını sıfırlayacaktır. 

 
Application[ "KS" ] = 0;  
 

ü void  Session_Start  metodu altına aşağıdaki kodları ekleyin. Bu kod 

uygulamada oturum açıldığında kullanıcı sayısını artıracaktır. 

 
Application[ "KS" ] = (( int )Application[ "KS" ]) + 1;  
 

ü void  Session_En d metodu altına aşağıdaki kodları ekleyin. Bu kod 

uygulamada oturum kapatıldığında kullanıcı sayısını azaltacaktır. 

 
Application[ "KS" ] = (( int )Application[ "KS" ]) -  1;  

 

ü MasterPage sayfası Page_Load olayına aşağıdaki kodu ekleyin. 

 
Label4.Text = Convert .ToSt ring(Application[ "KS" ]);  
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ü Uygulamayı çalıştırın ve online kullanıcı sayısını gözlemleyin. 

 

Resim 5.17: Online kullanıcı sayısı ekran çıktısı 
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UYGULAMA FAALİYETİ 
 

Durum yönetimi nesneleri ile ilgili aşağıdaki uygulamayı yapınız. 

 

İşlem Basamakları Öneriler 

ü Yeni bir boş web projesi oluşturun. 

ü File > New > Web Site  komutunu 

kullanabilirsiniz. 

ü New WebSite iletişim penceresinden 

ASP.NET Empty Web Site komutunu 

kullanabilirsiniz. 

ü Web sayfasını açın ve aşağıdaki 

tasarıma uygun kontrolleri sayfaya 

ekleyin. 

 

ü Toolbox panelini kullanabilirsiniz. 

ü Oturum yönetimini kontrol etmek için 

sayfa Page_Load olayına aşağıdaki 

kodları yazın. 

if  (Session[ "KullaniciAdi" ] == null )  

{  

 Label3.Text = ʏ:ÉÙÁÒÅÔëÉƞʏ;  

 Button2.Visible = false ;  

}  

else  

{  

 Label3.Text = 
Session[ "Kullani ciAdi" ].ToString();  

 Label1.Visible = false ;  

 Label2.Visible = false ;  

 TextBox1.Visible = false ;  

 TextBox2.Visible = false ;  

 Button1.Visible = false ;  

 Button2.Visible = true ;  

}  

 

ü Page_Load olayı kod sayfasına otomatik 

olarak eklenmiş durumda olacaktır. 

UYGULAMA FAALİYETİ 
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ü Giriĸ butonu Click olayına aşağıdaki 

kodları ekleyin. 

 
if  (TextBox1.Text == "Admin"  && 

TextBox2.Text == "1234" )  

{  

 Session.Add( "KullaniciAdi" , 

TextBox1.Text);  

 Label3.Text = 

Session[ "KullaniciAdi" ].ToString();  

Label1.Visible = false ;  

 Label2.Visible = false ;  

 TextBox1.Visible = false ;  

 TextBox2.Visible = false ;  

 Button1.Visible = false ;  

 Button2.Visible = true ;  

}  

ü Buton üzerinde çift tıklayarak Click 

olayını ekleyebilirsiniz. 

ü Oturumu kapat butonu Click butonuna 

aşağıdaki kodları yazın. 

 
Session.Abandon();  

Response.Redirect( "Default.aspx" );  

ü Buton üzerinde çift tıklayarak Click 

olayını ekleyebilirsiniz. 

ü Giriĸ Paneli altına aşağıdaki kontrolleri 

ekleyin. 

 

ü Toolbox panelini kullanabilirsiniz. 

ü Web sitesine Global.asax dosyası 

ekleyin. 

ü Add New Item iletişim penceresinden 

Global Application Class komutunu 

kullanabilirsiniz. 

ü void  Application_Start  metodu 

altına aşağıdaki kodları ekleyin.  

 
Application[ "KS" ] = 0;  
Application[ "TS" ] = 0;  
 
 
 

ü Bu kod ile uygulama başlatıldığında 

toplam ve online kullanıcı sayısını 

sıfırlayabilirsiniz. 
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ü void  Session_Start  metodu altına 

aşağıdaki kodları ekleyin.  

 
Application[ "KS" ] = (( int )  

Application[ "KS" ]) + 1;  
Application[ " TS"] = (( int )  

Application[ " TS"]) + 1;  

ü Bu kod ile oturum açıldığında online 

kullanıcı sayısı ve toplam kullanıcı 

sayısını artırabilirsiniz. 

ü void  Session_End  metodu altına 

aşağıdaki kodları ekleyin.  

 
Application[ "KS" ] = (( int )  

Application[ "KS" ]) -  1;  

ü Bu kod uygulamada oturum 

kapatıldığında online kullanıcı sayısını 

azaltacaktır. 

ü Aşağıdaki kodları sayfanın Page_Load 

olayına yazınız. 
Label4.Text = 
Convert .ToString(Application[ "KS" ]);  
Label 5.Text = 
Convert .ToString(Application[ " TS"]);  

ü Bu kodlar ile online kullanıcı sayısı ve 

toplam kullanıcı sayılarını kontrollere 

aktarabilirsiniz. 

ü Uygulamayı çalıştırın. 
ü Debug > Start Debugging (F5) 

komutunu kullanabilirsiniz. 
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KONTROL LİSTESİ 
 

 

Bu faaliyet kapsamında aşağıda listelenen davranışlardan kazandığınız beceriler için 

Evet, kazanamadığınız beceriler için Hayır kutucuğuna  (X) işareti koyarak kendinizi 

değerlendiriniz. 

 

Değerlendirme Ölçütleri Evet Hayır 

1. Oturum yönetimi nesnesini kullanabildiniz mi?   

2. Oturum açma – kapatma işlemlerini gerçekleştirebildiniz mi?   

3. Uygulama durum yönetimi nesnesini kullanabildiniz mi?   

4. Uygulama durum yönetimi için Global.asax dosyasını 

kodlayabildiniz mi? 
  

5. Online ve toplam kullanıcı sayılarını okutabildiniz mi?   

 

 

 

DEĞERLENDİRME 
 

Değerlendirme sonunda “Hayır” şeklindeki cevaplarınızı bir daha gözden geçiriniz. 

Kendinizi yeterli görmüyorsanız öğrenme faaliyetini tekrar ediniz. Bütün cevaplarınız 

“Evet” ise “Ölçme ve Değerlendirme”ye geçiniz. 
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ÖLÇME VE DEĞERLENDİRME 
Aşağıdaki cümlelerin başında boş bırakılan parantezlere, cümlelerde verilen 

bilgiler doğru ise D, yanlış ise Y yazınız. 
 

1. (   ) Durum yºnetim nesneleri verilen sunucu ya da istemci tarafında saklanması için 

kullanılır. 

 

2. ( ) QueryString nesnesi ile sayfalar arasında taşınacak veri direk olarak http 

aracılığıyla taşınır. 

 

3. (   ) QueryString taşınan veriler sayfa adresinde yer alan soru iĸareti (?) simgesinden 

sonra gösterilir. 

 

4. (  ) ViewState nesnesine veriler PostBack işleminden sonra şifrelenmiş bir şekilde 

yazılır. 

 

5. (   ) Cookie verileri sunucu üzerinde verileri fiziksel olarak saklamak için kullanılır. 

 

6. (   ) Cookie nesnesi ile ilgili işlemler yapılabilmesi için ASP.NET uygulamalarında 

HttpCookies sınıfı kullanılmaktadır. 

 

7. (  )Oturum açan her kullanıcı için oluşturulan SessionID değeri tekrar tekrar 

kullanılabilir. 

 

8. (   ) Application nesnesi ile web sitesinin tamamını ilgilendiren bilgiler tutulur. 

 

DEĞERLENDİRME 
 

Cevaplarınızı cevap anahtarıyla karşılaştırınız. Yanlış cevap verdiğiniz ya da cevap 

verirken tereddüt ettiğiniz sorularla ilgili konuları faaliyete geri dönerek tekrarlayınız. 

Cevaplarınızın tümü doğru ise “Modül Değerlendirme”ye geçiniz. 

ÖLÇME VE DEĞERLENDİRME 
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MODÜL DEĞERLENDİRME 
Aşağıdaki soruları dikkatlice okuyunuz ve doğru seçeneği işaretleyiniz. 

 

1. Anasayfa dosyalarının uzantısı aşağıdakilerden hangisidir? 

A) .aspx 

B) .asax 

C) .master 

D) .config 

 

2. Anasayfa dosyaları hangi direktif ile başlar? 

A) @Page 

B) @Master 

C) @Control 

D) @Register 

 

3. Aşağıdakilerden hangisi ContentPalceHolder kontrolü için yanlıştır? 

A) MasterPage sayfasından türeyen sayfalar için düzenlenebilir alanlardır. 

B) MasterPage sayfasında birden fazla ContentPlaceHolder kontrolü kullanılabilir. 

C) MasterPage sayfasında programlama yazılımı başlangıçta iki tane 

ContentPlaceHolder kontrolü ekler. 

D) MasterPage sayfasında programlama yazılımı başlangıçta eklenen 

ContentPlaceHolder kontrolleri silinemez. 

 

4. Stil sayfalarının dosya uzantısı aşağıdakilerden hangisidir? 

A) .aspx 

B) .css 

C) .master 

D) .config 

 

5. Stil sayfası kuralları belirlenirken kuralın isminin önünde aşağıdaki noktalama 

işaretlerinden hangisi kullanılır? 

A) Nokta ( ) 

B) Virgül (,) 

C) Ünlem (!) 

D) Noktalı Virgül (;) 

 

6. Stil dosyaları sayfalara bağlanırken hangi etiketler arasında tanımlanır? 

A) <body>…</body> 

B) <title>…</title> 

C) <head>…</head> 

D) <form>…</form> 

 

 

 

MODÜL DEĞERLENDİRME 
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7. ASP.NET web sitelerinde temalar hangi klasör altında tutulur? 

A) App_Data 

B) App_Themes 

C) App_Code 

D) App_Browser 

 

8. Dış görünüm dosyaları aşağıdakilerden hangisidir? 

A) Style Sheet 

B) Skin File 

C) SiteMap 

D) Text File 

 

9. Web sitesine tema uygulamak için hangi dosya kodlarına ekleme yapılmalıdır? 

A) Global.asax 

B) Web.sitemap 

C) Favicon.ico 

D) Web.config 

 

10. Çalışma zamanında sayfanın temasının belirlenmesi için gerekli kodlar hangi sayfa 

olayına yazılmalıdır? 

A) Page_Load 

B) Page_PreRender 

C) Page_Unload 

D) Page_PreInit 

 

11. Site haritası dosyasının uzantısı aşağıdakilerden hangisidir? 

A) .css 

B) .sitemap 

C) .config 

D) .asax 

 

12. Açılır menüler ile ilgili olarak aşağıdakilerden hangisi yanlıştır? 

A) Bir sayfaya birden fazla açılır menü oluşturulabilir. 

B) Açılır menülerin görünümleri değiştirilebilir. 

C) Açılır menü ögeleri sadece statik olarak eklenebilir. 

D) Açılır menü ögeleri seviyelere göre gruplanabilir. 

 

13. QueryString taşınan veriler sayfa adresinde yer alan hangi simgeden sonra gösterilir? 

A) ! (Ünlem) 

B) ? (Soru İşareti) 

C) * (Yıldız) 

D) = (Eşittir) 
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14. Aşağıdaki durum yönetim nesnelerinden hangisi verileri istemci bilgisayarında fiziksel 

olarak saklamak için kullanılır? 

A) QueryString 

B) ViewState 

C) Cookie 

D) Session 

 

15. Aşağıdaki durum yönetim nesnelerinden hangisinde tutulan veriler PostBack 

işleminden sonra şifreli olarak gönderilir? 

A) ViewState  

B) Cookie 

C) Application 

D) QueryString 

 

 

 

DEĞERLENDİRME 
 

Cevaplarınızı cevap anahtarıyla karşılaştırınız. Yanlış cevap verdiğiniz ya da cevap 

verirken tereddüt ettiğiniz sorularla ilgili konuları faaliyete geri dönerek tekrarlayınız. 

Cevaplarınızın tümü doğru ise bir sonraki modüle geçmek için öğretmeninize başvurunuz. 



 

 58 

 

CEVAP ANAHTARLARI 
ÖĞRENME FAALİYETİ-1’İN CEVAP ANAHTARI 

 

1 Doğru 

2 Yanlış 

3 Doğru 

4 Yanlış 

5 Yanlış 

6 Doğru 

7 Doğru 

8 Doğru 

 

ÖĞRENME FAALİYETİ-2’NİN CEVAP ANAHTARI 
 

1 Doğru 

2 Doğru 

3 Yanlış 

4 Doğru 

5 Yanlış 

6 Doğru 

 

ÖĞRENME FAALİYETİ-3’ÜN CEVAP ANAHTARI 
 

1 Doğru 

2 Doğru 

3 Doğru 

4 Yanlış 

5 Yanlış 

6 Doğru 

7 Yanlış 

8 Doğru 

 

 

 

 

 

 

 

 

CEVAP ANAHTARLARI 
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ÖĞRENME FAALİYETİ-4’ÜN CEVAP ANAHTARI 
 

1 Doğru 

2 Yanlış 

3 Doğru 

4 Doğru 

5 Yanlış 

6 Yanlış 

7 Doğru 

8 Doğru 
 

ÖĞRENME FAALİYETİ-5’İN CEVAP ANAHTARI 
 

1 Doğru 

2 Yanlış 

3 Doğru 

4 Doğru 

5 Yanlış 

6 Doğru 

7 Yanlış 

8 Doğru 
 

MODÜL DEĞERLENDİRME’NİN CEVAP ANAHTARI  
 

1 C 

2 B 

3 D 

4 B 

5 A 

6 C 

7 B 

8 B 

9 D 

10 D 

11 B 

12 C 

13 B 

14 C 

15 A 
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